4.1.1. Dodavanje i uklanjanje slike na web stranici
1
00:00:02,700 --> 00:00:03,966
Dobrodošli. 

2
00:00:03,966 --> 00:00:10,299
U ovoj lekciji vidjet ćemo ćemo na koji način 
možemo dodati ili ukloniti sliku s web stranice. 

3
00:00:10,300 --> 00:00:15,200
Web stranice vrlo često uz tekstualni sadržaj imaju 
i slike. 

4
00:00:15,200 --> 00:00:20,633
Kako bismo stranici dodali sliku, potrebno je pozicionirati se na mjesto na koje želimo sliku

5
00:00:20,633 --> 00:00:22,799
dodati. 

6
00:00:22,800 --> 00:00:29,433
Zatim iz izbornika Insert (Umetanje) treba 
odabrati Image (Slika). 

7
00:00:29,433 --> 00:00:35,633
U dijaloškom okviru Insert/Replace Image (Umetni/Promijeni sliku) potrebno je upisati 

8
00:00:35,633 --> 00:00:41,033
adresu putanje do slike. No nema potrebe tu putanju pisati rukom.

9
00:00:41,033 --> 00:00:47,333
Dovoljno je kliknuti na gumb Browse (Odaberi) te odabrati željenu sliku. 

10
00:00:47,333 --> 00:00:56,899
Mi ćemo iz mape images odabrati sliku 
image.jpg te potvrditi klikom na gumb Open. 

11
00:00:56,900 --> 00:01:04,000
Ostale postavke dijaloškog okvira Insert/Replace Image za sada nećemo dirati i potvrdit ćemo 

12
00:01:04,000 --> 00:01:10,700
klikom na gumb Confirm (Potvrdi).

13
00:01:10,700 --> 00:01:15,466
Vidimo da smo na našu web stranicu dodali sliku. 

14
00:01:15,466 --> 00:01:21,799
Spremit ćemo promjene i otvorit ćemo web preglednik. 

15
00:01:21,800 --> 00:01:31,966
Vidimo da na našoj stranici gdje smo umetnuli sliku trenutno nema slike, no osvježimo li stranicu, 

16
00:01:31,966 --> 00:01:36,366
vidimo da smo dobili i sliku.

17
00:01:36,366 --> 00:01:46,099
Kao što smo rekli, sliku s web stranice možemo i 
ukloniti. Vratit ćemo se stoga u Amayu. 

18
00:01:46,100 --> 00:01:55,066
Kako bismo uklonili sliku, dovoljno je tu sliku 
označiti te na tipkovnici pritisnuti tipku Delete. 

19
00:01:55,066 --> 00:01:58,166
Vidimo da je slika uklonjena. 

20
00:01:58,166 --> 00:02:05,299
Spremimo li promjene i osvježimo li stranicu u web pregledniku, vidimo da slike uistinu više 

21
00:02:05,300 --> 00:02:08,133
nema.  

22
00:02:08,133 --> 00:02:14,999
U ovoj lekciji vidjeli smo na koji način možemo 
dodati ili ukloniti sliku s web stranice.

23
00:02:15,000 --> 00:02:19,500


24
00:02:19,500 --> 00:02:21,366
Hvala na pažnji.


4.1.2. Postavljanje, izmjena atributa slike: veličina, obrub, poravnanje, alternativni tekst
1
00:00:03,233 --> 00:00:11,433
Dobrodošli. U ovoj lekciji upoznat ćemo na koji 
način možemo postaviti, izmjeniti atribute slike: 

2
00:00:11,433 --> 00:00:16,566
veličinu, obrub, poravnanje i alternativni tekst.

3
00:00:16,566 --> 00:00:19,399


4
00:00:19,400 --> 00:00:24,966
Kako bismo promijenili neka svojstva slike, kao i 
za ostale elemente koje želimo mijenjati,

5
00:00:24,966 --> 00:00:28,366
 prvo je potrebno označiti ju.

6
00:00:28,366 --> 00:00:34,666
Ukoliko želimo promijeniti njezinu veličinu, dovoljno je povući mišem jedan od držača oko 

7
00:00:34,666 --> 00:00:41,066
slike. Ukoliko ulovimo one na kutevima, mijenjat ćemo visinu i širinu. 

8
00:00:41,066 --> 00:00:46,199


9
00:00:46,200 --> 00:00:57,033
Ukoliko ulovimo ostale, mijenjamo ili samo visinu 
ili samo širinu.  

10
00:00:57,033 --> 00:01:04,633
No na taj način možemo deformirati sliku, pa 
ćemo poništiti naredbe.

11
00:01:04,633 --> 00:01:12,299
Kako bismo zadržali pravilan odnos (ratio) tj. proporcionalnost izmeđ u visine i širine, potrebno 

12
00:01:12,300 --> 00:01:20,400
je prilikom povlačenja i promjene veličine držati i pritisnutu dodatno tipku Shift.

13
00:01:20,400 --> 00:01:26,033
Ovime odnos između visine i širine ostaje isti.

14
00:01:26,033 --> 00:01:34,566
Naravno, sliku ne bismo smjeli previše povećati 
zbog toga što kvarimo njezinu kvalitetu tj. rezoluciju 

15
00:01:34,566 --> 00:01:40,499
i dobivamo previše istaknute pixele, koji se u 
pravilu ne bi smjeli vidjeti.

16
00:01:40,500 --> 00:01:47,733
Stoga je sliku bolje uvijek obraditi u nekom 
grafičkom programu pa je gotovu ubaciti u našu 

17
00:01:47,733 --> 00:01:58,433
web stranicu ili eventualno smanjiti njezinu veličinu kako se ne bi pokvarila niti rezolucija niti kvaliteta  

18
00:01:58,433 --> 00:02:03,299
odnosa između visine i širine slike.

19
00:02:03,300 --> 00:02:11,766
U uvodu smo spomenuli da slika može imati i obrub. Kako bismo slici podesili obrub, potrebno  

20
00:02:11,766 --> 00:02:17,599
je iz izbornika Format odabrati Style editor.

21
00:02:17,600 --> 00:02:26,166
U dijaloškom okviru Style, na kartici Colors u donjem dijelu prozora treba izabrati željenu boju 

22
00:02:26,166 --> 00:02:30,532
obruba, kao i ostala svojstva. 

23
00:02:30,533 --> 00:02:42,433
Mi ćemo podesiti da želimo obrub debljine 1px, solid (znači da će biti puna linija), a za boju ćemo 

24
00:02:42,433 --> 00:02:53,366
kliknuti na Selektor boje i izabrat ćemo bijelu boju  te potvrditi na gumb OK

25
00:02:53,366 --> 00:03:01,366
Mogli smo podesiti i samo neki od obruba, tako da odaberemo bilo gornji, bilo donji, bilo lijevi ili 

26
00:03:01,366 --> 00:03:10,832
desni. No mi smo postavili sve obrube. Potvrdit ćemo klikom na gumb Apply.

27
00:03:10,833 --> 00:03:17,866
Vidimo da je naša slika dobila jedan tanki bijeli 
obrub.

28
00:03:17,866 --> 00:03:23,166
Sljedeće svojstvo (atribut) koji možemo podesiti je 
poravnanje slike. 

29
00:03:23,166 --> 00:03:28,099
U ovom primjeru jedne jednostavne stranice, vidimo da slika na nekoj web stranici može biti  

30
00:03:28,100 --> 00:03:29,933
poravnata na više načina.

31
00:03:29,933 --> 00:03:37,099
Može biti u ravnini s tekstom, no može biti i lijevo od teksta, samostalno u sredini, ili desno od 

32
00:03:37,100 --> 00:03:42,533
teksta. Postavimo sada i sami poravnanje slike.

33
00:03:42,533 --> 00:03:51,999
Prvo je sliku potrebno označiti, a zatim iz izbornika 
Insert odabrati Image (slika). 

34
00:03:52,000 --> 00:04:00,833
Otvara nam se prozor Insert/Replace Image (Umetni/Izmijeni Sliku). Mi nećemo mijenjati cijelu 

35
00:04:00,833 --> 00:04:05,666
sliku, no hoćemo njezino poravnanje. 

36
00:04:05,666 --> 00:04:13,366
Pod Position vidimo četiri ranije spomenuta načina poravnavanja slike: u ravnini s tekstom, 

37
00:04:13,366 --> 00:04:18,766
lijevo od teksta, u sredini ili desno od teksta.

38
00:04:18,766 --> 00:04:26,999
Mi ćemo odabrati desno od teksta i pritisnuti gumb Confirm. 

39
00:04:27,000 --> 00:04:32,700
Vidimo da je slika otišla u desnu stranu.

40
00:04:32,700 --> 00:04:37,000
Konačno u uvodu smo spomenuli i alternativni 
tekst. 

41
00:04:37,000 --> 00:04:42,566
Alternativni tekst je atribut slike koji bi b ilo dobro uvijek koristiti. 

42
00:04:42,566 --> 00:04:49,599
Ako iz nekog razloga web preglednik ne uspije učitati sliku, alternativni tekst je ono što će se  

43
00:04:49,600 --> 00:04:56,966
učitati i reći korisniku "ovdje postoji slika na kojoj je prikazano to i to". Osim toga, neki ljudi zbog 

44
00:04:56,966 --> 00:05:04,166
poteškoća s vidom, bilo da su slijepi ili slabovidni ne mogu vidjeti sliku, no oni koriste programe koji 

45
00:05:04,166 --> 00:05:12,432
im čitaju tekst. Kada takav program naleti na sliku, on će pročitati atribut alternativnog teksta te će 

46
00:05:12,433 --> 00:05:15,199
osoba znati što je na slici.

47
00:05:15,200 --> 00:05:22,400
Stoga bi to trebao biti vrlo kratki opis ili naziv slike tj. onoga što slika prikazuje.

48
00:05:22,400 --> 00:05:29,266
Kako bismo dodali alternativni tekst potrebno je označiti sliku te iz izbornika Insert odabrati 

49
00:05:29,266 --> 00:05:31,466
Image. 

50
00:05:31,466 --> 00:05:37,732
U dijaloškom okviru Insert/Replace Image vidimo polje Alternate text.

51
00:05:37,733 --> 00:05:40,733
U njega unosimo željeni tekst. 

52
00:05:40,733 --> 00:05:49,199
Mi ćemo postaviti “primjer slike s desne strane“, 
te pritisnuti gumb Confirm.  

53
00:05:49,200 --> 00:05:59,133
Naravno, ukoliko je sa slikom sve u redu i nakon 
osvježavanja stranice slika će biti prikazana. 

54
00:05:59,133 --> 00:06:05,599
Vidimo da se sada učitala i gornja slika zbog toga što je ranije očito postojala greška u kodu ili slike 

55
00:06:05,600 --> 00:06:11,300
jednostavno nije bilo pa je zbog toga prikazao alternativni tekst.   

56
00:06:11,300 --> 00:06:20,166
U ovoj lekciji vidjeli smo na koji način možemo postaviti, izmijeniti atribute slike: veličinu, obrub, 

57
00:06:20,166 --> 00:06:23,666
poravnanje, alternativni tekst.

58
00:06:23,666 --> 00:06:27,366


59
00:06:27,366 --> 00:06:29,699
Hvala na pažnji.



4.2.1. Dodavanje obrasca na web stranicu
1
00:00:03,800 --> 00:00:05,266
Dobrodošli.

2
00:00:05,266 --> 00:00:11,399
U ovoj lekciji upoznat ćemo na koji način možemo dodati obrazac (formu) na web stranicu.

3
00:00:11,400 --> 00:00:17,833
Obrasci su interaktivni elementi koji omogućavaju primanje različitih informacija od posjetitelja 

4
00:00:17,833 --> 00:00:19,133
stranica. 

5
00:00:19,133 --> 00:00:25,233
Po strukturi su slični pisanim obrascima koje često susrećemo u svakodnevnom životu i 

6
00:00:25,233 --> 00:00:28,299
postupak popunjavanja je vrlo jednostavan. 

7
00:00:28,300 --> 00:00:35,766
Čitatelj (posjetitelj) upisuje tražene informacije u polja obrasca. Kada završi, sadržaj obrasca šalje  

8
00:00:35,766 --> 00:00:39,699
se na obradu skripti koja se nalazi na poslužitelju. 

9
00:00:39,700 --> 00:00:45,866
Poslužitelj obrađuje sadržaj obrasca i izvršava određenu akciju, ovisno o namjeni. To može biti 

10
00:00:45,866 --> 00:00:50,932
prijava u sustav, slanje elektroničke pošte i sl.

11
00:00:50,933 --> 00:00:58,066
Izrada skripti je nešto složenija i nije dio ove edukacije, nego samo izrada samih obrazaca i 

12
00:00:58,066 --> 00:01:00,932
njihovih elemenata.

13
00:01:00,933 --> 00:01:07,366
Vrlo često obrasci su zaseban dio web stranice, prikazan kao jedna cjelina ili još češće kao 

14
00:01:07,366 --> 00:01:09,232
odvojena stranica. 

15
00:01:09,233 --> 00:01:17,999
On može sadržavati različite tipove polja. Neka od 
njih su tekstualni okviri, polja za unos teksta, 

16
00:01:18,000 --> 00:01:23,033
padajući izbornici, kružni izbornici, 

17
00:01:23,033 --> 00:01:25,199
kontrolni kvadratići

18
00:01:25,200 --> 00:01:28,266
i gumbi.

19
00:01:28,266 --> 00:01:34,466
Mi ćemo obrazac kreirati na novoj stranici i u idućih nekoliko lekcija napravit ćemo jedan mali 

20
00:01:34,466 --> 00:01:37,232
obrazac za kontakt. 

21
00:01:37,233 --> 00:01:45,199
Prvo je potrebno pozicionirati se na mjesto gdje 
će biti obrazac. Zatim iz izbornika Insert (Umetni) 

22
00:01:45,200 --> 00:01:54,133
odabiremo Form (Obrazac), te potom Insert a Form (Umetni obrazac). Otvara nam se dijaloški 

23
00:01:54,133 --> 00:01:57,699
okvir Attributes (atributi). 

24
00:01:57,700 --> 00:02:02,500
Jedan od najvažnijih atributa je action (akcija). 

25
00:02:02,500 --> 00:02:08,400
Najjednostavnije rečeno, to je uputa pregledniku što da radi s podatcima iz obrasca. 

26
00:02:08,400 --> 00:02:16,666
Mi ćemo naš obrazac slati na mail, stoga ćemo upisati mailto: i mail adresu na koju se šalju 

27
00:02:16,666 --> 00:02:25,699
podatci iz obrasca npr. mailto:ivan.horvat@nekaadresa.hr. 

28
00:02:25,700 --> 00:02:30,500
Za kraj ćemo stisnuti gumb OK.

29
00:02:30,500 --> 00:02:37,500
Vizualno ne vidimo ništa jer obrazac je samo 
„okvir“ koji sadrži elemente obrasca. 

30
00:02:37,500 --> 00:02:47,100
No u tag selektoru vidimo da obrazac postoji 
budući da vidimo element (tag) form. 

31
00:02:47,100 --> 00:02:54,433
U idućim lekcijama dodat ćemo i elemente našem 
obrascu.

32
00:02:54,433 --> 00:03:01,499
U ovoj lekciji vidjeli smo na koji način možemo 
dodati obrazac (formu) na našu web stranicu.

33
00:03:01,500 --> 00:03:05,500


34
00:03:05,500 --> 00:03:07,033
Hvala na pažnji.



4.2.2. Dodavanje, uklanjanje tekstualnog polja od jednog i više redaka
1
00:00:02,933 --> 00:00:09,066
Dobrodošli. U ovoj lekciji vidjet ćemo na koji način obrascu možemo dodati tekstualni okvir od jednog 

2
00:00:09,066 --> 00:00:12,899
i više redaka te kako ih možemo ukloniti.

3
00:00:12,900 --> 00:00:19,600
Tekstualni okvir od jednog reda (single-line) kao što mu i naziv kaže služi za unos teksta koji stane 

4
00:00:19,600 --> 00:00:26,900
u jedan red poput imena, prezimena, adrese, grada, zanimanja i sl. Kako bismo dodali bilo  

5
00:00:26,900 --> 00:00:31,400
kakvo polje prvo ćemo ubaciti element koji senaziva Label (naziv). 

6
00:00:31,400 --> 00:00:37,466
Njega koristimo kako bi se ispred polja za unos napisao pojam koji ide u to polje kako bi 

7
00:00:37,466 --> 00:00:44,066
posjetitelji znali što moraju upisati u njega npr. ime.

8
00:00:44,066 --> 00:00:53,699
Iz izbornika Insert (Umetni) odabrat ćemo Form 
(Obrazac) te potom Label.

9
00:00:53,700 --> 00:01:01,166
Upisat ćemo Ime: jer želimo da posjetitelji unesu 
ime. Sada ćemo ubaciti tekstualni okvir. 

10
00:01:01,166 --> 00:01:07,599
Ponovimo postupak i pozovimo iz Izbornika Insert 
> Form. 

11
00:01:07,600 --> 00:01:16,400
Potom odabiremo Text (input) koji će nam ubaciti 
tekstualno polje. 

12
00:01:16,400 --> 00:01:30,366
Unijet ćemo i polje prezime. Prvo ćemo umetnuti 
jedan label i upisati prezime, a zatim ćemo iz 

13
00:01:30,366 --> 00:01:39,632
izbornika Insert > Form ubaciti i tekstualno polje 
za unos prezimena.

14
00:01:39,633 --> 00:01:44,599
Unesimo sada tekstualno polje od više redaka 
(multi-line). 

15
00:01:44,600 --> 00:01:51,533
Ponovno ćemo dodati label i napisat ćemo poruka: jer želimo da nam posjetitelji naše stranice 

16
00:01:51,533 --> 00:01:55,666
ostave, ukoliko to žele, neku poruku.

17
00:01:55,666 --> 00:02:02,966
Potom ubacimo i samo polje koje se naziva 
textarea. Iz izbornika Insert odabrat ćemo Form, 

18
00:02:02,966 --> 00:02:07,266
te potom textarea (područje za tekst). 

19
00:02:07,266 --> 00:02:10,966
Vidimo da je ovo polje nešto veće.

20
00:02:10,966 --> 00:02:17,666
Ukoliko spremimo promjene i učitamo našu web stranicu u web pregledniku, vidimo da smo dobili 

21
00:02:17,666 --> 00:02:26,066
početak kontakt obrasca sa 3 polja za unos sadržaja s time da je zadnje polje, polje za unos 

22
00:02:26,066 --> 00:02:28,999
veće količine teksta.

23
00:02:29,000 --> 00:02:32,066
Vratimo se natrag u Amayu.

24
00:02:32,066 --> 00:02:39,732
Ukoliko poželimo neko polje ukloniti iz našeg 
obrasca, dovoljno je taj element označiti (pritom ne 

25
00:02:39,733 --> 00:02:47,733
zaboravite niti label) i na tipkovnici pritisnuti tipku 
Delete.

26
00:02:47,733 --> 00:02:55,299
Vidimo da polja više nema. Na taj način mogli 
bismo ukloniti i bilo koje drugo polje. 

27
00:02:55,300 --> 00:03:02,600
Ovaj puta nećemo spremiti promjene jer će nam 
polje Prezime trebati u idućim vježbama.

28
00:03:02,600 --> 00:03:08,233
U ovoj lekciji vidjeli smo na koji način obrascu možemo dodati tekstualni okvir od jednog i više 

29
00:03:08,233 --> 00:03:11,766
redaka te kako ih možemo ukloniti.

30
00:03:11,766 --> 00:03:14,599


31
00:03:14,600 --> 00:03:19,766
Hvala na pažnji.



4.2.3. Dodavanje, uklanjanje polja obrasca: padajući izbornici, kvadratići za označavanje, kružni izbornici
1
00:00:05,033 --> 00:00:12,533
Dobrodošli. U ovoj lekciji upoznat ćemo na koji način možemo dodati, ukloniti polja obrasca kao 

2
00:00:12,533 --> 00:00:18,966
što su: padajući izbornik, kvadratići za  označavanje i kružni izbornici.

3
00:00:18,966 --> 00:00:24,899
Padajući izbornici (drop-down menus), koriste se kako bi osoba mogla izabrati nešto iz 

4
00:00:24,900 --> 00:00:32,533
ponuđenog popisa. To može biti npr. popis mjesta ili stupanj obrazovanja.

5
00:00:32,533 --> 00:00:39,799
Prvo ćemo kao i uvijek dodati Label (natpis) kako 
bi osoba znala što izabire iz nekoga popisa. 

6
00:00:39,800 --> 00:00:49,433
Iz izbornika Insert > Form, odabrat ćemo Label. 
Upisat ćemo Mjesto stanovanja:

7
00:00:49,433 --> 00:00:52,366
Sada trebamo dodati padajući izbornik. 

8
00:00:52,366 --> 00:00:55,866
Kako bismo dodali padajući izbornik, iz izbornika 

9
00:00:55,866 --> 00:01:02,332
Insert > Form odabiremo Menu (izbornik). 

10
00:01:02,333 --> 00:01:11,199
U element koji se pojavio upisati ćemo 
Dubrovnik. To je prva stavka našega izbornika. 

11
00:01:11,200 --> 00:01:17,366
No, izbornik bez više stavki nema baš smisla, 
stoga moramo dodati još nekoliko stavki. 

12
00:01:17,366 --> 00:01:22,932
Kako je Amaya jednostavan program, nećemo 
nažalost to moći napraviti u vizualnom dijelu. 

13
00:01:22,933 --> 00:01:28,933
Stoga ćemo iznimno napraviti ovo u kodu bez 
posebnih objašnjenja HTML koda. 

14
00:01:28,933 --> 00:01:34,533
Iz izbornika Views (Pogledi) odabrat ćemo Split 
view horizontally. 

15
00:01:34,533 --> 00:01:39,833
U donjem dijelu prozora vidimo sada našu stranicu 
pisanu u kodu. 

16
00:01:39,833 --> 00:01:47,133
Red koji nama treba je element <option> koji prikazuje opcije tj. mogućnosti izbornika. Označit 

17
00:01:47,133 --> 00:01:57,699
ćemo redak, jedini koji za sad imamo i iz izbornika Edit odabrati Copy (kopiraj). Zatim ćemo 

18
00:01:57,700 --> 00:02:03,966
zalijepiti opciju još dva puta preko Edit > Paste (zalijepi). 

19
00:02:03,966 --> 00:02:16,066
Želimo imati tri grada. Izmijenit ćemo nazive 
gradova i upisat ćemo još Rijeka te Zagreb.

20
00:02:16,066 --> 00:02:26,166
Konačno  moramo izbrisati atribut selected (odabrano), jer ne mogu biti odabrana tri grada 

21
00:02:26,166 --> 00:02:30,466
nego samo jedan. 

22
00:02:30,466 --> 00:02:36,199
Kada smo sve završili, vratit ćemo se natrag u pogled dizajna i zatvoriti prikaz koda preko  

23
00:02:36,200 --> 00:02:43,533
izbornika Views > Split view horizontally. 

24
00:02:43,533 --> 00:02:51,299
Spremit ćemo promjene i otvoriti naš web 
preglednik te osvježiti stranicu. 

25
00:02:51,300 --> 00:03:01,100
Vidimo da smo dobili padajući izbornik s tri grada: 
Dubrovnikom, Rijekom i Zagrebom.

26
00:03:01,100 --> 00:03:08,600
Vratit ćemo se natrag u Amayu kako bismo dodali 
kvadratiće za označavanje.

27
00:03:08,600 --> 00:03:14,466
Kvadratići za označavanje (checkbox) 
upotrebljavaju se kada posjetitelju želite omogućiti 

28
00:03:14,466 --> 00:03:19,166
izbor od nijedne, jedne ili više ponuđenih 
mogućnosti.

29
00:03:19,166 --> 00:03:27,432
Za početak ćemo kao i obično dodati label (natpis). Upisat ćemo: Lekcija: jer korisniku 

30
00:03:27,433 --> 00:03:31,266
nudimo izbor lekcije koju želi slušati.

31
00:03:31,266 --> 00:03:38,966
Kako bismo dodali kvadratić za označavanje potrebno je kliknuti na Insert > Form te odabrati 

32
00:03:38,966 --> 00:03:43,932
Checkbox (kvadratić za označavanje).

33
00:03:43,933 --> 00:03:52,666
Ponudit ćemo korisniku dvije lekcije. Jedna je 
Linkovi, a drugu ćemo staviti Tablice. 

34
00:03:52,666 --> 00:04:02,932
Ponovno iz izbornika Insert moramo odabrati 
Form > Checkbox i upisati Tablice.

35
00:04:02,933 --> 00:04:10,099
Ukoliko želimo da korisnik može odabrati samo 
jednu od opcija, moramo koristiti kružne izbornike.

36
00:04:10,100 --> 00:04:16,166
Kružni izbornici (radio buttons) koriste se, kada želite postići da posjetitelj odabere samo jednu 

37
00:04:16,166 --> 00:04:20,599
vrijednost iz nekog konačnog ponuđenog popisa.

38
00:04:20,600 --> 00:04:26,833
Za početak ćemo dodati natpis, kako bi korisnik znao što odabrati. Recimo da se naši tečajevi 

39
00:04:26,833 --> 00:04:32,899
plaćaju. Stoga ćemo upisati Način plaćanja: 

40
00:04:32,900 --> 00:04:37,466
Potom ćemo iz izbornika Insert odabrati Form, i kako bismo dodali kružni izbornik, odabrati Radio 

41
00:04:37,466 --> 00:04:39,566
(kružni izbornik).

42
00:04:39,566 --> 00:04:48,866
Omogućit ćemo posjetiteljima da mogu platiti gotovinom i karticama. Moramo dodati još jedan 

43
00:04:48,866 --> 00:05:01,866
kružni izbornik i upisat ćemo karticama.

44
00:05:01,866 --> 00:05:11,366
Spremit ćemo promjene u naš dokument i 
prebacit ćemo se u web preglednik. 

45
00:05:11,366 --> 00:05:19,899
Osvježit ćemo našu stranicu. Vidimo da posjetitelj 
može izabrati mjesto stanovanja. 

46
00:05:19,900 --> 00:05:29,266
Potom lekciju pri čemu može odabrati bilo jednu, 
bilo dvije ali isto tako i niti jednu.

47
00:05:29,266 --> 00:05:36,632
I način plaćanja može biti samo jedan. Naravno, ukoliko posjetitelj ne sluša lekcije neće odabrati 

48
00:05:36,633 --> 00:05:40,766
niti opcije plaćanja.

49
00:05:40,766 --> 00:05:46,499
Bilo koje od polja koje smo maloprije unijeli možemo jednostavno i ukloniti. Stoga ćemo se 

50
00:05:46,500 --> 00:05:50,800
vratiti natrag u program Amayu. 

51
00:05:50,800 --> 00:05:58,566
Kako bismo uklonili neko od polja tj. od elemenata 
koje smo dodali u obrazac, dovoljno je taj element 

52
00:05:58,566 --> 00:06:04,832
označiti i na tipkovnici stisnuti tipku Delete.

53
00:06:04,833 --> 00:06:15,299
Na ovaj način, mogli smo ukloniti i izbornik i 
kvadratiće za označavanje i kružne izbornike.

54
00:06:15,300 --> 00:06:23,900
U ovoj lekciji vidjeli smo na koji način možemo dodati, ukloniti polja obrasca: padajući izbornik, 

55
00:06:23,900 --> 00:06:28,466
kvadratići za označavanje i kružni izbornici.

56
00:06:28,466 --> 00:06:31,832


57
00:06:31,833 --> 00:06:35,266
Hvala na pažnji.


4.2.4. Postavljanje, izmjena svojstava polja obrasca
1
00:00:06,833 --> 00:00:13,966
Dobrodošli. U ovoj lekciji upoznat ćemo na koji način možemo postaviti, izmijeniti svojstva polja 

2
00:00:13,966 --> 00:00:21,299
obrasca: tekstualnog polja, padajućeg izbornika, kvadratića za označavanje i kružnog izbornika.

3
00:00:21,300 --> 00:00:27,000
Svako polje obrasca može imati različita svojstva, 
ovisno o kojem se polju radi. 

4
00:00:27,000 --> 00:00:32,033
Pogledajmo za polja koja smo obradili u ranijim 
lekcijama samo neka od tih svojstava. 

5
00:00:32,033 --> 00:00:39,133
Svojstva (attributes) podešavat ćemo kroz panel 
alata Attributes, na način da ćemo uvijek prvo 

6
00:00:39,133 --> 00:00:47,199
kroz tag selector označiti element, te potom dodati 
i izmijeniti svojstva elementa.

7
00:00:47,200 --> 00:00:56,500
Označimo prvo tekstualno polje (text-field) 'ime' 
tj. element input u tag selektoru.

8
00:00:56,500 --> 00:01:06,100
Vidimo da u panelu Attributes trenutno imamo samo jedno svojstvo, a to je type i vrijednost: text. 

9
00:01:06,100 --> 00:01:08,966
Dodat ćemo još nekoliko svojstava. 

10
00:01:08,966 --> 00:01:15,766
Nova svojstva dodaju se iz izbornika Insert, na 
način da se odabere željeno svojstvo. 

11
00:01:15,766 --> 00:01:22,232
Mi ćemo odabrati svojstvo Size tj. koliko će 
znakova biti širina polja. 

12
00:01:22,233 --> 00:01:30,533
Postavit ćemo vrijednost na 40 s time da se ne može upisati brojka nego morate kliknuti na  

13
00:01:30,533 --> 00:01:36,333
strelice ili držati strelice da bi se brojka povećala odnosno smanjila ovisno o tome koju vrijednost 

14
00:01:36,333 --> 00:01:38,633
želite unijeti.

15
00:01:38,633 --> 00:01:48,666
Budući da mi želimo unijeti vrijednost 40, za kraj tj. 
za potvrdu ćemo stisnuti gumb Apply. 

16
00:01:48,666 --> 00:01:56,532
Vidimo da je naše polje sada šire, njegova širina je 40 znakova, no ono može primiti i više znakova,  

17
00:01:56,533 --> 00:02:00,099
samo je vizualno široko 40 znakova.

18
00:02:00,100 --> 00:02:09,766
Drugo svojstvo koje možemo dodati je maxlength. 
Iz izbornika Insert odabrat ćemo maxlength. 

19
00:02:09,766 --> 00:02:14,532
To je maksimalni broj znakova koji može biti 
unesen u neko polje. 

20
00:02:14,533 --> 00:02:23,733
Recimo da je dovoljno da ime ima 20 znakova, pa ćemo postaviti vrijednost na 20 i potvrdit ćemo 

21
00:02:23,733 --> 00:02:27,333
klikom na gumb Apply. 

22
00:02:27,333 --> 00:02:34,366
Sada neće biti moguće unijeti više od 20 znakova 
u polje ime.

23
00:02:34,366 --> 00:02:44,332
Odaberimo sada polje poruke (textarea). Vidimo 
da u panelu Attributes piše cols: 20 i rows: 4.

24
00:02:44,333 --> 00:02:51,733
To znači da vizualno stane 20 znakova u redu i da imamo 4 reda. Povećat ćemo vrijednost cols na 

25
00:02:51,733 --> 00:02:52,899
40 znakova. 

26
00:02:52,900 --> 00:03:00,800
Označimo svojstvo i pritisnemo strelice kako bi se vrijednost svojstva povećala te potvrdimo na gumb  

27
00:03:00,800 --> 00:03:07,400
Apply. Vidimo da je polje za tekst sada šire.

28
00:03:07,400 --> 00:03:15,600
Odaberimo sad Padajući izbornik. Prvo ćemo 
odabrati element select. 

29
00:03:15,600 --> 00:03:20,600
Ovdje ćemo postaviti svojstvo name i vrijednost na 
mjesto. 

30
00:03:20,600 --> 00:03:27,466
Svojstvo name važno nam je jer se kod prosljeđivanja podataka na e-mail prosljeđuju 

31
00:03:27,466 --> 00:03:35,866
upravo taj podatak, dakle mjesto i vrijednost koju je posjetitelj odabrao, npr. Rijeka.

32
00:03:35,866 --> 00:03:44,732
No, također vidimo da je trenutno Dubrovnik 
odabran i da ima vrijednost selected: selected. 

33
00:03:44,733 --> 00:03:51,599
Sjetimo se da je jedna stavka u izborniku uvijek 
označena, najčešće prva. 

34
00:03:51,600 --> 00:03:57,166
No ukoliko kliknemo na malu strelicu kod Dubrovnika, dobit ćemo sve stavke našega  

35
00:03:57,166 --> 00:03:58,732
izbornika. 

36
00:03:58,733 --> 00:04:06,599
Ukoliko odaberemo Rijeku vidimo da sada Rijeka 
ima vrijednost selected. 

37
00:04:06,600 --> 00:04:13,100
Kvadratići za označavanje i kružni izbornici mogu imati svojstvo checked (odabrano) s vrijednošću 

38
00:04:13,100 --> 00:04:16,600
Yes (da), odnosno No (ne). 

39
00:04:16,600 --> 00:04:23,833
Ukoliko je vrijednost Yes (da) vidimo da je polje u startu odabrano kako za kvadratić za označavanje 

40
00:04:23,833 --> 00:04:28,033
tako i za kružni izbornik. 

41
00:04:28,033 --> 00:04:34,066
Ukoliko vrijednost želimo promijeniti iz No u Yes dovoljno je označiti svojstvo i iz padajućeg 

42
00:04:34,066 --> 00:04:38,932
izbornika promijeniti svojstvo u Yes.

43
00:04:38,933 --> 00:04:45,599
Vidimo da sada način plaćanja u startu ima 
gotovinu.

44
00:04:45,600 --> 00:04:52,433
Konačno pogledajmo još jedno svojstvo vezano uz 
kružni izbornik. 

45
00:04:52,433 --> 00:04:57,766
Vidimo svojstvo name sa vrijednošću radio. 

46
00:04:57,766 --> 00:05:00,999
Svojstvo name je vrlo bitno svojstvo. 

47
00:05:01,000 --> 00:05:07,266
Ukoliko označimo neki drugi radio, tj. neki drugi kružni izbornik njegovo ime (name) mora biti 

48
00:05:07,266 --> 00:05:13,532
indentično tj. u našem slučaju radio. 

49
00:05:13,533 --> 00:05:20,166
Kako bi posjetitelj stranice uistinu mogao odabrati samo jednu opciju, samo jedan kružić, name za  

50
00:05:20,166 --> 00:05:22,699
sve kružiće mora biti isti. 

51
00:05:22,700 --> 00:05:29,533
U protivnom posjetitelj će moći kliknuti na više njih, a za takve odabire trebali bismo koristiti 

52
00:05:29,533 --> 00:05:33,133
kvadratiće za označavanje. 

53
00:05:33,133 --> 00:05:37,466
Spremimo promjene na našoj stranici.

54
00:05:37,466 --> 00:05:43,266
Prebacimo se u web preglednik i osvježimo 
stranicu.

55
00:05:43,266 --> 00:05:53,366
Vidimo da naš obrazac sada malo drugačije 
izgleda. Polje ime je šire, isto kao i polje poruke. 

56
00:05:53,366 --> 00:05:59,399
Padajući izbornik više ne počinje s Dubrovnikom 
nego s Rijekom, a u startu je već odabrana 

57
00:05:59,400 --> 00:06:06,766
metoda plaćanja gotovinom jednako kao i lekcija 
Linkovi. 

58
00:06:06,766 --> 00:06:13,832
Naravno mogli smo na svim ovim elementima 
postaviti neka druga svojstva tj. atribute.

59
00:06:13,833 --> 00:06:20,833
No probajte neka od tih svojstava isprobati i sami.

60
00:06:20,833 --> 00:06:28,033
U ovoj lekciji vidjeli smo na koji način možemo postaviti, izmijeniti svojstva polja obrasca: 

61
00:06:28,033 --> 00:06:34,933
tekstualnog, padajućeg izbornika, kvadratića za označavanje i kružnog izbornika.

62
00:06:34,933 --> 00:06:38,833
 

63
00:06:38,833 --> 00:06:42,933
Hvala na pažnji.



4.2.5. Dodavanje, uklanjanje gumba pošalji (submit)  i resetiraj (reset)
1
00:00:04,633 --> 00:00:06,033
Dobrodošli.

2
00:00:06,033 --> 00:00:14,999
U ovoj lekciji upoznat ćemo na koji način možemo dodati, ukloniti gumbe pošalji i resetiraj. 

3
00:00:15,000 --> 00:00:21,266
Nakon što se popuni obrazac potrebno je popunjene podatke proslijediti dalje na obradu ili  

4
00:00:21,266 --> 00:00:27,799
na mail. Kako bi posjetitelj to mogao napraviti u pravilu stisne gumb pošalji.

5
00:00:27,800 --> 00:00:34,000
Stoga ćemo dodati gumb pošalji (submit) našem 
obrascu. 

6
00:00:34,000 --> 00:00:43,333
Iz izbornika Insert > Form (obrazac) odabiremo 
Submit (pošalji). 

7
00:00:43,333 --> 00:00:50,166
Klikom na taj gumb izvršava se akcija koju smo 
postavili prilikom stvaranja obrasca.

8
00:00:50,166 --> 00:00:58,866
Dodat ćemo još jedan gumb. Na isti način se 
može dodati i gumb reset (resetiraj) 

9
00:00:58,866 --> 00:01:08,399
Kliknemo na Insert > Form te potom odaberemo 
Reset (resetiraj, obriši).

10
00:01:08,400 --> 00:01:16,266
Klikom na ovaj gumb, posjetitelj može jednim 
klikom pobrisati sve podatke iz obrasca.

11
00:01:16,266 --> 00:01:23,766
Ukoliko se predomislimo i poželimo ukloniti neki od ova dva gumba, ili čak oba gumba (što nije 

12
00:01:23,766 --> 00:01:31,499
preporučljivo budući da nam gumbi trebaju, osobito Submit), dovoljno je označiti željeni gumb  

13
00:01:31,500 --> 00:01:37,766
te na tipkovnici pritisnuti tipku Delete. Vidimo dasmo gumb uklonili. 

14
00:01:37,766 --> 00:01:45,899
No mi ćemo poništiti akciju i vratiti gumb, jer nam 
trebaju oba gumba.

15
00:01:45,900 --> 00:01:53,933
Spremit ćemo promjene i osvježiti stranicu u web 
pregledniku.

16
00:01:53,933 --> 00:01:59,199
Vidimo da su se pojavila i dva gumba koja smo 
maloprije kreirali. 

17
00:01:59,200 --> 00:02:09,666
Unijet ćemo samo nekoliko podataka, poput 
imena, mjesta stanovanja i načina plaćanja te 

18
00:02:09,666 --> 00:02:17,999
stisnuti gumb Reset da vidimo da li će se naš 
obrazac vratiti na prvotne postavke.

19
00:02:18,000 --> 00:02:24,433
Vidimo da se obrazac vratio u prvotno stanje: 
nema unesenog imena, mjesto stanovanja je 

20
00:02:24,433 --> 00:02:28,766
Rijeka, a način plaćanja je kao što je bio u startu 
gotovinom.

21
00:02:28,766 --> 00:02:31,032

22
00:02:31,033 --> 00:02:39,399
U ovoj lekciji vidjeli smo na koji način možemo dodati ili ukloniti gumb pošalji (submit) i resetiraj 

23
00:02:39,400 --> 00:02:42,900
(reset).

24
00:02:42,900 --> 00:02:45,166


25
00:02:45,166 --> 00:02:47,366
[bookmark: _GoBack]Hvala na pažnji.

4.2.6. Postavljanje i izmjena svojstava gumba
1
00:00:03,066 --> 00:00:04,332
Dobrodošli.

2
00:00:04,333 --> 00:00:12,166
U ovoj lekciji vidjet ćemo na koji način možemo postaviti i izmjeniti svojstva gumba šalji (submit) i 

3
00:00:12,166 --> 00:00:15,032
resetiraj (reset).

4
00:00:15,033 --> 00:00:21,966
Nakon što smo postavili gumbe submit i reset na 
naš obrazac, promijenit ćemo im svojstvo value. 

5
00:00:21,966 --> 00:00:30,132
Svojstvo Value govori što je napisano na gumbu.
Označimo prvo gumb Submit. 

6
00:00:30,133 --> 00:00:37,233
U panelu (alatima) Attributes vidimo da je 
vrijednost svojstva Value: Submit. 

7
00:00:37,233 --> 00:00:44,933
Izmijenit ćemo to svojstvo u Pošalji, na način da označimo svojstvo i u donjem kvadratiću upišemo  

8
00:00:44,933 --> 00:00:47,599
novi tekst koji bi trebao pisati.

9
00:00:47,600 --> 00:00:55,133
Upišimo: Pošalji. Za kraj ćemo pritisnuti gumb 
Apply.

10
00:00:55,133 --> 00:00:59,433
Vidimo da se tekst na gumbu promijenio u Pošalji.

11
00:00:59,433 --> 00:01:09,233
Isto to napravimo i s gumbom Reset. Prvo označimo gumb, a zatim ćemo vrijednost Value, , 

12
00:01:09,233 --> 00:01:16,066
umjesto Reset, postaviti na Obriši.

13
00:01:16,066 --> 00:01:20,932
Potvrdit ćemo gumbom Apply.

14
00:01:20,933 --> 00:01:30,666
Sada na oba gumba imamo hrvatske nazive. Za 
kraj spremimo promjenu na stranici.

15
00:01:30,666 --> 00:01:38,899
U ovoj lekciji vidjeli smo na koji način možemo postaviti i izmjeniti svojstva gumba šalji (submit) i 

16
00:01:38,900 --> 00:01:43,133
resetiraj, obriši (reset).

17
00:01:43,133 --> 00:01:45,699
 

18
00:01:45,700 --> 00:01:47,433
Hvala na pažnji.



4.2.7. Postavljanje i izmjena akcije za slanje obrasca putem maila
1
00:00:05,400 --> 00:00:12,300
Dobrodošli. U ovoj lekciji upoznat ćemo na koji način možemo postaviti, izmijeniti akciju za slanje 

2
00:00:12,300 --> 00:00:14,333
obrasca putem maila.

3
00:00:14,333 --> 00:00:20,233
Kako bi se podatci uneseni u obrazac pritiskom 
na gumb Pošalji (Submit) mogli proslijediti na 

4
00:00:20,233 --> 00:00:27,333
obradu ili na mail, obrazac mora imati postavljen 
atribut action (akcija). 

5
00:00:27,333 --> 00:00:31,333
Akciju smo postavljali prilikom stvaranja obrasca.

6
00:00:31,333 --> 00:00:41,633
Akcija može biti ili mail adresa ili mail skripta. U 
našem primjeru mi smo postavili mail adresu. 

7
00:00:41,633 --> 00:00:47,466
Označimo cijelu formu u tag selectoru. 

8
00:00:47,466 --> 00:00:50,466
Kliknuli smo na form.

9
00:00:50,466 --> 00:00:59,232
U panelu (alatima) Attributes vidimo da postoji samo jedno svojstvo a to je action i da ima 

10
00:00:59,233 --> 00:01:14,199
vrijednost mailto:ivan.horvat@nekaadresa.hr tj govori da će se klikom na gumb Pošalji (submit) 

11
00:01:14,200 --> 00:01:20,200
proslijedi sadržaj obrasca na ovu mail adresu. 

12
00:01:20,200 --> 00:01:26,933
U ranijim lekcijama rekli smo da postavljanje akcije s mail adresom automatski poziva zadani  

13
00:01:26,933 --> 00:01:36,233
mail klijent (poput Outlooka) i iz njega šalje podatke iz obrasca na unesenu adresu. Rekli smo  

14
00:01:36,233 --> 00:01:42,633
da je to nekad loše rješenje jer nemaju svi ljudi naračunalu program za mail već neki koriste i web 

15
00:01:42,633 --> 00:01:46,699
mail poput Gmaila ili Yahoo maila.

16
00:01:46,700 --> 00:01:56,866
S druge strane, mail skripte poput npr. mail.php ili mail.asp neizostavno uključuju i programiranje  

17
00:01:56,866 --> 00:02:00,632
koje nije dio ovog programa obrazovanja. 

18
00:02:00,633 --> 00:02:04,566
No na Internetu ima velik broj takvih skripti. 

19
00:02:04,566 --> 00:02:10,632
Potrebno je samo pretražiti Internet, naći odgovarajuću skriptu i postupiti prema uputama za  

20
00:02:10,633 --> 00:02:13,899
primjenu odabrane skripte.

21
00:02:13,900 --> 00:02:23,500
No korištenje mail adrese nije dakle pogrešno 
stoga za početak slobodno koristite takvu akciju.

22
00:02:23,500 --> 00:02:31,500
Mi ćemo izmijeniti našu adresu da ne ide na mailto:ivan.horvat nego da ide na adresu 

23
00:02:31,500 --> 00:02:36,200
marko.matic@nekaadresa.hr. 

24
00:02:36,200 --> 00:02:45,100
Označit ćemo action i u donjem kvadratiću gdje 
piše stara adresa izbrisat ćemo staru adresu.

25
00:02:45,100 --> 00:02:54,000
Riječ mailto: trebali bismo pustiti zbog toga što 
ona govori da će biti proslijeđeno na neki mail.

26
00:02:54,000 --> 00:03:06,966
Unijet ćemo novu adresu i cijeli izraz sada glasi: 
mailto:marko.matic@nekaadresa.hr. 

27
00:03:06,966 --> 00:03:11,366
Potvrdit ćemo gumbom Apply.

28
00:03:11,366 --> 00:03:19,066
Ovime smo izmijenili adresu na koju se prosljeđuju 
podatci našega obrasca.

29
00:03:19,066 --> 00:03:25,966
U ovoj lekciji vidjeli smo na koji način možemo  postaviti, izmijeniti akciju za slanje obrasca putem 

30
00:03:25,966 --> 00:03:28,366
maila.

31
00:03:28,366 --> 00:03:30,366


32
00:03:30,366 --> 00:03:33,132
Hvala na pažnji.

